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TERRAIN SCULPTOR PRO User Manual 
 
Terrain Sculptor Pro (TS Pro) is a utility to assist you in creating and editing Microsoft Flight 
Simulator® and Lockheed Martin Prepar3D® (collectively “FlightSim”) terrain around your airport 
(or anywhere else) representative of the real world – including creating undulations therein.  
While other more-general-purpose tools, such as sBuilder and ADE also do some of this, 
Terrain Sculptor Pro’s user interface is tailored to these specific functions and much of the 
“grunt-work” required by those other tools is not necessary with TS Pro.  Instead of requiring 
you to draw every sloped poly individually, TS Pro allows you to place a single node where the 
polys will intersect and to specify the elevation of this point.  And, instead of hand-crafting 
individual blending triangles to mate with the existing mesh, Terrain Sculptor slews the user 
aircraft along a boundary you specify (with a few points), recording the mesh elevation and 
automatically creating the necessary blend triangles.  
 
Terrain Sculptor Pro can operate stand-alone and create terrain files from scratch, or it can 
import terrain files in sBuilder .sbx file format or FlightSim .bgl format.  An interface with ADE is 
planned. Terrain Sculptor Pro compiles directly for all versions of Flightsim, including automatic 
clipping.  Thus, sculpted terrain files initially imported from either version of sBuilder or from 
.bgls may be exported to any FlightSim version. (FSX and P3D require shp2vec.exe from the 
SDK be installed on your computer since Microsoft’s licensing terms do not permit it to be 
incorporated.). 
 
Terrain Sculptor Pro incorporates (with permission): 

 Patrick Germain’s CVX Extractor.exe, by, and 
 Winfried Orthmann’s xml2shp.exe. 

 
References to “sBuilder” in this manual are intended to mean both sBuilder and sBuilderX. 

Installing, Executing and Uninstalling TERRAIN SCULPTOR PRO 

Installation - To install Terrain Sculptor Pro, simply copy all the files from the downloaded 
archive into a folder of your choice which will be referred to as your Terrain Sculptor Pro folder. 
 
Terrain Sculptor Pro does not affect the system registry. 
 
Terrain Sculptor Pro is a Microsoft NET.Framework 4.5 application.  CVX Extractor is a 
NET.Framework 4.5 application.   If NET.Framework 4.5 or later is not already installed on your 
computer, the “redistributable” can be downloaded from the Microsoft website at no charge. 
 
Terrain Sculptor Pro communicates with FlightSim via FSUIPC (FS9, FSX and P3D) or 
SimConnect (FSX and P3D).  SimConnect is an integral part of FSX and P3D.  For FS9, 
FUISPC is necessary.  Of course, communication via FSUIPC requires that FSUIPC be 
installed on your system.  If you do not have FSUIPC or, in the case of P3D, the correct version 
of FSUIPC, you may download it from http://www.schiratti.com/dowson.html.  
 
Execution - To execute Terrain Sculptor Pro, double-click on TS Pro.exe.  
 
Users of Vista and later versions of Windows usually must have and, depending on 
circumstances, others may require, administrator privileges when running Terrain Sculptor Pro.  
If you do not have administrator privileges, you may not be able to access/write the necessary 
files.  To run Terrain Sculptor Pro with administrator privileges, right-click Terrain Sculptor 
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Pro.exe, select “Run As …” and then “administrator”.  Such issues can sometimes be avoided 
by installing Terrain Sculptor Pro on other than the C: drive. 
 
Windows 7 users may wish to run Terrain Sculptor Pro in the XP compatibility mode.  Running it 
otherwise results in a "this program may not have installed correctly" message when Terrain 
Sculptor Pro is shut-down.  Despite the error message, there is no known problem - other than 
the annoyance factor. 
 
Initialization - When you shut-down Terrain Sculptor Pro for the first time, an additional file, 
TS.ini, will be created and saved to the Terrain Sculptor Pro folder.  Terrain Sculptor Pro 
"remembers" key settings from one session to the next.  Those settings are in TS Pro.ini.  The 
next time Terrain Sculptor Pro is run, the settings are preselected based on this file. 
 
Automatic Updates - Whenever Terrain Sculptor Pro is started, it checks the support server to 
determine if a more recent release is available.  If so, it will download that release with your 
consent. The updated release must be manually installed in the normal manner.  Unless there 
are special instructions, just copy the new files into your Terrain Sculptor Pro folder, overwriting 
their pre-existing counterparts. 
   
If you decline an update, you will be asked if you wish to be advised of future updates.  If you 
decline, the "Check for Updates at Startup" item in the Options menu file will be unchecked.  To 
reinstate automatic update checking, check this menu item. 
 
Un-Installation - To uninstall Terrain Sculptor Pro, just delete the Terrain Sculptor Pro folder and 
all its contents. 

The Data Display Area 

Shown below is Terrain Sculptor Pro’s Main Panel.  The display area, which occupies the bulk 
of the dialog, shows a finished terrain file for my CYYJ, originally imported from sBuilderX with 
which it was created several years ago.  In that area you see:  

 triangles – blend nodes, named so because they outline where the contoured area is to 
blend with the existing mesh  

 crosses – sculpt nodes, i.e. elevation points; you may specify as many as you like and in 
whatever configuration you prefer 

 nodes – which may form polygons or lines for a multitude of purposes.  Depending on 
the select terrain type, polygons may represent (contoured) flattens or landclass – or 
holes in same; lines may represent open terrain contours, roads, shorelines, etc. 

 
As you will later see, open contours are generally used to limit/block the effects of adjacent 
slopes in places where a series of sculpt nodes may not provide satisfactory results. 
 
When you place the cursor over any displayed element, if Show Tooltips in the Options menu is 
checked, a tooltip showing the data associated with that node is displayed. 
 
Near the bottom of the data display area are two text strings: 

 Cursor Posn – showing the geographic position of the mouse cursor “hot-spot”, and 
 Displayed Area – showing the size of the data display area at the current zoom level. 

 
If any version of Flightsim is running, the user aircraft will be shown as a cross when it is within 
the display area.   
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The display area includes both a foreground and a background.  All TS Pro data manipulations 
are conducted in the foreground.  You may call for reference data to be loaded into the 
background, for example, stock road data if you are laying out or tweaking the position of roads.   
Data may be copied from the background to the foreground.  You may also call for an airport 
diagram to be loaded into the background.  All background data will all be displayed in a 
medium-grey color.   
 

 
 

Terrain Sculptor Pro’s Main Panel 
 

Main Panel Controls 

All other Terrain Sculptor Pro operations are initiated from the Main Panel menu bar or from a 
context menu shown following a right-click with the cursor anywhere in the display area.   
 
Across the top of the Main Panel is a menu bar containing five items: 

 Files – creating, opening, importing and exporting data files and for importing 
background files 

 View – selecting the data elements to be displayed 
 Mode – selecting the type(s) of terrain available for editing purposes 
 Nodes –on data and related profiles (discussed later) 
 Options – selection of options and display formats, and 
 Help – version information and on-line access to this user manual. 

 
Above the data display to the right are two combo boxes.  The first, Terrain .Cfg, permits 
selection of an alternate terrain.cfg file from any installed version of Flightsim - permitting use of 
add-on terrain types.  (Terrain Sculptor Pro includes the updated stock FSX terrain.cfg.)  The 
other, Terrain Type, selects the terrain type to be used for any nodes subsequently placed and, 
optionally, any nodes currently selected.)  To the right of the Terrain Type combobox is the Inc. 
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Non-Stock Items checkbox.  When checked, any add-on terrain types included in the selected 
terrain.cfg file are available for editing purposes. 
 
When Flightsim is running, Terrain Sculptor Pro reports the ground elevation under the user 
aircraft near the upper-right corner of the Main Panel. 
 
The Zoom controls are located in the upper right corner of the Main Panel.  Left-clicking these 
buttons will increase or decrease the geographic area displayed by 10%.  If you depress and 
hold-down the left mouse button, the displayed area will continue to increase or decrease for so 
long as the mouse button is held down.  You may also zoom the display from the mouse-wheel 
with a 10% change per click.  Scroll bars are displayed as necessary. 
 
To change the center location of the display, depress the mouse-wheel with the cursor 
positioned anywhere in the display area and move the mouse.  The display will follow.  Or, re-
center the display to the aircraft position or to a specific latitude and longitude using the Nodes / 
Re-Center Display … menu items 
 
When Flightsim is running (connection from Terrain Sculptor Pro will be automatic), you may 
slew the user aircraft using either the Main Panel Slew controls or by moving the cursor over the 
aircraft symbol on the display, depressing the left mouse button and dragging the symbol (and 
the user aircraft) to the desired position.  Normally, Flightsim will be paused following any slew 
operation.  You may override this by checking the No Pause After Slew box. 
 
Undo and Redo buttons are below the slew controls.  (Ctrl-Z and Ctrl-Y may also be used.)  If 
you delete or add back a node near the edge of the display, the data may re-center.  Not all 
operations can be undone/redone. 
 
Files Menu 

The files menu is used to start new projects and load and save project files.  Many of the items 
in the this menu are associated with a listbox that displays the names of the files recently 
selected for the corresponding function.  To reselect one of those files, simply click on its name.  
To select a new file, click on the menu item and navigate to the file of interest. 

 
The Files menu contains the following items: 

 New Project – Clears any existing data and opens a second dialog that allows you to 
specify a name of the new project and enter a geographic center position.  The position 
my be entered directly  or you may click the Get Airport Position button and specify a 
.bgl file containing the airport of interest.  The airport’s.ARP will be used as the center 
position.  A benefit to selecting an airport is that, following clicking the Start Project 
button on the second dialog, a diagram of the airport layout will be displayed in the 
background 

 Open Project – Loads a previously-saved project (.tsd file) into the foreground 

 Append to Project – Adds data from another file to the project 

 Import .bgl as Project – Loads the data from a FS9 or FSX/P3D .terrain .bgl into the 
foreground. 

 Import .sbx as Project - Loads the data from a sBuilder or sBuilderX .sbx file into the 
foreground. 

 Save Project – Saves the current project as a .tsd file 

 Save Project as … - Saves the current project as a .tsd file to be named 
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 Update Terrain.cfg File(s) – Appearing only when custom terrains exist, this menu item 
adds any custom terrains to the bottom of Flightsim terrain.cfg files (see Custom Terrain 
below in this section).  If you have more than one version of Flightsim installed, you will 
have the option of selecting the versions to be updated. 

 Export to FS9 –  Compiles the current project data into FS9 TDF- and/or LWM- 
formatted .bgl file(s), as applicable 

 Export to FSX/P3D – Compiles the current project data into a FSX/P3D  CVX-formatted 
.bgl file 

 Load .bgl as Background – Loads the data from a FS9 or FSX/P3D .terrain .bgl into the 
background. 

 Load .sbx as Background - Loads the data from sBuilder or sBuilderX .sbx file into the 
background. 

 Add Airport to Background – Draws an outline of the selected airport in the background.  
If the specified file contains more than one airport, you will be asked to select the one of 
interest. 

 Delete Background – deletes all the background data 
 

Custom Terrain – As discussed under Editing List Parameters and Individual Nodes, TS Pro can 
create and use custom terrains.  They are held in a file named “Terrain_Custom.cfg” (in the 
main TS Pro folder) in the same format as Flightsim’s Terrain.cfg.  Custom terrains do not 
appear in the Main Panel Terrain Type combobox.  They may only be assigned using the Node 
Editor.   
 
Elements using custom terrains will not be visible in Flightsim until the relevant Flightsim 
terrain.cfg file(s) have been updated.  Since updating the file can be a rather complex operation 
and an erroneous update can affect overall Flightsim operation, TS Pro has automated the 
process 
 

View Menu 

The View Menu, as the name suggests, controls what is seen in the display area at any time.  
None of the operations affect the foreground data.  Polygons may be displayed either filled or 
just as an outline. 
 

Mode Menu 

The Mode Menu, control what type(s) of elements may be manipulated in the foreground.  The 
contents of the Terrain Type combobox is limited to the types of terrain enabled in the Mode 
Menu. 
 
Nodes Menu 

The Nodes Menu contains the controls associated with blend profile generation and 
triangulation as well as a few other miscellaneous controls. 

 AutoBlend – Creates a set of blend points around your project at a distance and at 
interval you specify and triangulates the area.  Useful for testing the requirements for a 
blend outline. 

 Profile Blend Outline – Slews the user aircraft around the set of blend points, recording 
ground elevation at intervals you specify and inserting new profile nodes when elevation 
changes by an amount greater then the one you specify. 

 Triangulate – Triangulates the flattens of your project. 



01 January, 2021 6 

 Clear Triangulation – Restores the display to pre-triangulation state. 

 Check Elevation Differences – Generates a list of locations where the elevations of two 
or more closely spaced flatten and sculpt nodes differs by more than a specified amount. 

 Locate Elevation Differences – Selects  closely spaced flatten and sculpt nodes whose 
elevations differ by more than a specified amount. 

 Load Blend Points – Loads a set of blend points (.tsb file) Like several of the Files menu 
functions, this item is associated with a listbox holding recently-used files. 

 Save Blend Points As … - Saves the current set of blend points in a .tsb file.  If present, 
blend points are also saved in a project file. 

 Clear Blend Points – Clears the current set of blend points. 

 Load Profile Points – Loads blend profile (.tsp file). Like several of the Files Menu 
functions, this item is associated with a listbox holding recently-used files. 

 Save Profile Points As … - - Saves the current blend profile in a .tsp file.  If present, the 
blend profile is also saved in a project file. 

 Clear Profile Points - Clears the current blend profile. 

 Examine Current .shp Files – Displays the contents of the most recently-compiler shape 
files 

 

Options Menu 

The Options menu contains the following items: 

 Display Formats/Units – opens a second dialog from which you select lat/lon display 
format and distance and elevation units  

 Use FS9 Attributes – When checked, inputs and terrain selections will be interpreted in 
the context of FS9. Otherwise the FSX/P3D context is applicable. 

 Select Proximity (pixels) - the maximum distance between the mouse cursor “hot-spot”  
and the center of a displayed node or the user aircraft symbol for selection of that 
node/symbol to occur. 

 Mouse Breakout (pixels) – the minimum distance the mouse cursor must be moved 
before a node or the user aircraft symbol will be “dragged” from its position. 

 Ignore Elevation Differences (units) < – depending on prior processing, tiny deviations in, 
say, the elevation of flatten nodes which are intended to be identical, may have crept in.  
This entry will cause such deviations to be ignored, the elevation of all node of the flatten 
being set to their average. 

 Size of BG Exclude Rect (.nm.) – The displayed size of the rectangle for excludes 
applied to elements displayed in the background. 

 Auto-Consolidate – When importing data, the difference in lateral position and elevation 
less than which two points will be consolidated at an intermediate position/elevation.   

 Load Last Project on Startup – When checked, the project/file being operated upon 
when Terrain Sculptor Pro was last shutdown will be loaded automatically on the next 
startup, at the zoom level in effect at shutdown. 

 Suppress Confirmation Queries – By default, Terrain Sculptor Pro will seek your 
confirmation before performing an irreversible operation.  These repeated queries could 
become annoying and may be suppressed by checking this item. 

 Check for Updates at Startup - TS Pro can access its website server to determine if a 
new general release or development release is available.  When either is checked, 
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Terrain Sculptor Pro will attempt to find an updated version at startup.  If that operation is 
suppressed and you click on this item, Terrain Sculptor Pro searches for an update 
immediately.  You can also check for an update from the Help menu. 

 Reposition Aircraft when Data Loaded – When checked, if FlightSim is running when a 
new data file is loaded, the user aircraft will be repositioned to the geographic center of 
the data. 

 Show Tooltips – When checked, a tooltip is displayed whenever the mouse cursor 
hovers over a terrain element or the user aircraft symbol displaying positional and other 
information. 

 Enable Hot-Cursor – Please see the description of “hot-cursor” below in the discussion 
of the context menu 

 Default Flatten Terrain Type – Permits selection of a default terrain type which is 
automatically assigned to all newly-entered flatten nodes. 

 Use XML2Shp – Forces compilation of all shape files by XML2Shp. 

Creating/Editing Data 

By design, a menu item is not enabled unless it can be used in the current context.  If a 
control you want to use is not enabled, all required prerequisite data has not been 
entered or a necessary selection has not been made. 
 
To start, either load a project, import a .bgl or .sbx file, or select the type of data you wish to 
enter from the Mode menu and then right-click on the display and select a Start option from the 
context menu. (See “Starting from Scratch”, later.) 
 
Most operations on individual nodes are initiated from a context menu activated by a mouse 
right-click while in the data display area.  Generally, if a specific node is to be affected, e.g., to 
be moved to the aircraft position, right-click on that node or the line leading to it.  If, instead, a 
node is to be used as a reference, e.g., to place another node of the same type  in the same 
element, select the node (if one is not already selected) as described in the following paragraph, 
move the cursor to where the new node is to be placed and then right-click.  A list of possible 
actions is displayed (the “context menu”). 
 
To select a node, place the cursor over the node of interest or over the connecting line leading 
to it (or within the number of pixels you specify with the Options / Select Proximity – pixels 
function).  The node will change colour to orange.  Then, left-click the mouse; the node turns 
red, indicating it is selected).  You may select multiple nodes using the Ctrl and Shift keys in the 
usual manner or by placing the cursor away from any node - which will become one corner of a 
select-box, depressing the left mouse button and, with that button remaining depressed, moving 
the mouse to the diametrically opposite corner of the select box.  As you move the mouse, 
“captured” nodes will be selected and turn red. 
 
When you select a node, the Terrain Type combo box will display the type of terrain currently 
assigned to that node and its associated nodes.  (All nodes comprising a flatten or hole are of 
the same type).  If you wish to change the type of that node and its associates, click on the 
combo box and select the new type from its dropdown list.  (To avoid unintentional operations, 
Terrain Sculptor Pro will seek your confirmation before making the change.) 
 
While most node operations are initiated from the context menu, you may optionally use a hot-
cursor to add contour, blend and sculpt nodes with a simple left-click – thus reducing the 
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number of mouse-clicks by half.  Hot-cursor is enabled by the Hot Cursor checkbox in the 
Options menu.  (“Hot-cursor” is a term I coined from old aviator war movies when weapons 
which are enabled are “hot”)  The feature is automatically invoked (when enabled) whenever the 
Add/Replace Node context menu function is used with a contour or blend node selected.  It is 
terminated by a mouse right-click.  The Add/Replace Node context menu item is suffixed with 
“(Hot Cursor)” whenever hot-cursor is enabled. 
 
The functions activated from the context menu follow, several of which may be enabled/disabled 
depending on which, if any, nodes are selected and whether or not FlightSim is active: 
 
Enabled (when 
nodes selected) 

0 1 >1 

 

    Function 

x x x Start – Click this item to create a new element.  A sub-menu is displayed 
from which you select the type of element start at the cursor position.  You 
are then taken to the List/Node Editor to specify the remaining parameters. 
Once you close the editor a node will appear in the display area and you 
may specify additional nodes using the “hot cursor”. 

  x x Add New type Node at Cursor – the new node will be entered into the 
currently selected element immediately counter-clockwise of the current-
selected node in that element.  The menu item text will  suffixed with “(Hot 
cursor)” should that latter option be selected. 

  x  Add New type Node at A/C – Similar to Add New type Node at Cursor 
(“Hot-cursor” is not relevant) 

x x  Move Node to A/C – Move selected node to the position of the user aircraft.

x   Select Elements by Name – A listbox displaying the names of all the visible 
elements is displayed.  Select the element of interest. 

 x x Select Peer Nodes – Selects all nodes of the same category as the 
selected node. 

x x  Edit Node – A small dialog that allows redefinition of all aspects of the 
selected node or list. 

 x x Convert Selected Nodes to Sculpts – As the name suggests; selected 
sculpt nodes are ignored 

  x Consolidate Selected Nodes – Creates a new single node at an 
intermediate position.  If one or more sculpt nodes are selected along with 
a blend, contour or hole node, the sculpt node(s) is/are simply deleted. 

 x x Delete Selected Nodes – The selected nodes are deleted. 

 x  Add Background Element to Project – The highlighted background item is 
added to the project and a small exclusion rectangle inserted. 

 x  Exclude Background Element – Inserts an exclude rectangle for the 
highlighted background item. 

x x x A/C to Cursor – Move user aircraft to the cursor position 

 x  A/C to Selected Node – move user aircraft to the selected node 
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Enabled (when 
nodes selected) 

0 1 >1 

 

    Function 

 
 
 
 

x x x Recenter Display On … - displays a sub-menu from which you can select 
from Project (all project data is considered in establishing the new center), 
Cursor or User Aircraft.   

x x x Resequence Data … - displays a sub-menu from which you can move the 
currently-selected element up or down in or to the top or bottom of the 
sequence in which the elements are displayed. 

x x x Change Color – Displays the Change Color dialog (below) which permits 
you to change the color in which each element is displayed and/or the 
opacity of the fill-color of polys. 

 

 
 

Change Color Dialog 
 
You may also delete nodes by selecting the nodes and depressing the keyboard Del key. 
 
A node may be dragged to a new position by selecting it and, with the left mouse button still 
depressed, moving the cursor to the desired new position.  To avoid inadvertent moves, a node 
will not move until the cursor has been moved more that the breakout distance.  That distance is 
set using the Mouse Breakout (pixels) function under the Options menu.  If you want to move a 
node less than the breakout distance, move the cursor at least the breakout distance – at which 
point the node will jump to the cursor – and then move the cursor back to the desired position. 
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All nodes to form a polygon must be entered in counter-clockwise order – no matter the 
technique is used to enter them.  When inserting a new node into an existing outline, ensure 
the node selected prior to right-clicking is the one that will become the immediate clockwise 
neighbour of the new node.  (To facilitate inserting of nodes, when the mouse if hovering over 
any node, the next line counter-clockwise, I.e., into which the node will be inserted, is 
highlighted.)  The new node will be automatically selected in preparation for the entry of the next 
new node.  You can also verify that outline nodes are in the correct order from the tooltip which 
should show an increasing index number as nodes are examined in a counter-clockwise 
manner. 
 
The nodes of lines also must be entered sequentially.  The first node entered is displayed 
brighter than its successors to later identify it as the starting point.  Similar to entering nodes in 
polygons, to enter a new node in a line, select the node immediately previous to the position into 
which you want to insert the new node.  To enter a new node before the start node, move the 
start node to where you want the new start of the line to be and insert the new node at the 
position of the previous start. 
 
When you start a contour that is to contain nodes with differing elevations, you are given the 
option of placing all nodes without elevation data – which is sometimes more convenient than 
interrupting placement to enter elevation.  Of course, you’ll then need to edit each node 
individually. 
 
Sculpt nodes, which define terrain elevation at a specific point, may be placed wherever you 
want and in any order/configuration you like. The only restriction is that all sculpt nodes must lie 
within the blend outline and should not be placed in a flattened area unless they lie within a 
hole.  Terrain Sculptor Pro will not stop you from placing nodes in “restricted areas”, but will 
warn you of such situations and highlight the offending node before compiling your data.  If you 
elect not to correct the situation before compiling, you may find a few “unsculpted” areas in the 
result.  These areas will be obvious once you’ve triangulated the data (see below). 
 
For flattens, you may specify different terrain poly types among your nodes.  (This parameter 
will be ignored when outputting for FS9 which supports only a single flatten poly type.)  During 
triangulation, the terrain type used for a triangle will be the one specified for at least two of its 
nodes.  If all three nodes differ, any one of them may “rule”.  Nodes adopt the terrain type 
displayed in the Terrain Type combobox at the time the node is created.  To change that terrain 
type, select the nodes to be changed and then choose the new type in the Terrain Type 
combobox.  If the desired new type is already displayed in the combobox, select any other type, 
respond “No” to the challenge and then re-select the desired new type.  You can also change 
the terrain type assigned to a sculpt node using the Node edit feature described below. 
 
Two features under the Nodes menu may be of assistance in locating problem slopes: 

 Check Elevation Differences, and 
 Locate Elevation Differences 

The first will list the position of all situations where the elevation change between two points 
within the Options/Auto-Consolidate Lateral distance exceeds the Auto-Consolidate Elevation 
limit.  The second allows you to select the corresponding node on the Main Panel by clicking on 
any item in that list.  
 
Editing List Parameters and Individual Nodes – You may edit any of the parameters of a list or 
of an individual node except type.  Right-click on the node or line of interest (or select it and 
right-click in an empty area) and choose Edit Node.  A small dialog as shown below is opened.   
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You may also assign a new terrain type to individual nodes or, in the case of lines, to all nodes 
in the list, by selecting the node(s) of interest and then selecting the new terrain in the Terrain 
combobox. 
 
Illustrated below is the Edit Node dialog for a road.  It contains a feature not available for other 
elements, that is, the No Lights or Autogen checkbox.  All stock roads in Flightsim have 
simulated vehicle lights at night and, in the case of FSX and P3D, sometimes autogen signs and 
telephone/power poles alongside.  This is generally not suitable for service roads within the 
airport perimeter.   
 
 

 
 

Edit Node Dialog 
 

Checking the No Lights or Autogen checkbox results in the creation of a custom version of the 
selected terrain with that night lighting and any autogen is suppressed..  The name of the new 
terrain will be the old terrain name suffixed with “ – No Lights or Autogen”.  Once such a custom 
terrain has been created, it may be assigned to other roads either by selecting the custom name 
from the Terrain combobox or by checking the No Lights or Autogen checkbox.   
 
That box is automatically checked when a road using a custom terrain is opened in the editor. 
To revert to the original stock terrain assignment, simply uncheck No Lights or Autogen. 
 
Otherwise, edit as required and Save (or not).  Upon closing the Node Editor following creation 
of a new custom terrain you will be reminded to update the Flightsim terrain.cfg file(s) - see 
Update Terrain.cfg File(s) under the Files menu. 

Data File Operations 

The following text describes the creation/editing of sculpted flattens.  It is, however, directly 
applicable to the creation/editing of other types of data – with the exception, of course, of 
references to sculpt nodes. 

Project Data - If you’ve already saved data in Terrain Sculptor Pro, reload that data (“.tsd” file 
extension) using the Projects/Files menu Open Project function.  The last up-to-10 projects 
loaded will be displayed when the mouse enters the menu item.  Either select from that list or 
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click on the menu item to otherwise specify the file.  You may also append data from another 
.tsd file to the open currently loaded. 
 
Importing Data - If you have already created a terrain file for your airport, start by importing that 
data into Terrain Sculptor Pro. As for Projects/Open Projects (above), the last up-to-10 imports 
of the selected type loaded will be displayed when the mouse enters the Open item.  Either 
select from that list or click on the menu item to otherwise specify the file.  You may import: 

 previously-compiled .bgl files (for FSX/P3D, using the XML output of Patrick Germain’s 
integrated CVX Extractor); you will have the option of loading all the data in the file or 
only a portion by defining a bounding box;  due to precision constraints on CVX 
Extractor’s inputs, you may get data covering a larger (but still manageable) area than 
specified in the bounding box. 

 FS9 .bgl files, you’ll probably want to import both the LWM2 and LWM3 files if both exist, 
appending one to the other; and 

 sBuilder/sBuilderX .sbx files (if the file does not exist in .sbx format, open your existing 
flatten file in sBuilder or sBuilderX, as applicable, and export it in SBX format), 

 

 
 

Data Import Dialog 
 

Select the source of choice. For .sbx files, you will be presented with a small dialog similar to 
the following.  The most recently imported file will be shown in the Path textbox. 
 
Click Import File.  The data will be displayed as illustrated above.  The contours and any holes 
will be outlined. Unless the imported data includes a blend poly, all the remaining nodes will be 
sculpts.  You will add/adjust the blend outline later. 
 
Imported data will not include sculpt nodes.  So, it will probably be more convenient to display 
imported data in the Fill Polygon mode, selectable from the View menu – as illustrated above.   
 
Following import of the file, Terrain Sculptor Pro will list any situation where two or more nodes 
lie within the Lateral Distance limit of each other have elevation differences greater than the 
Elevation Difference specification.  For convenience, you may print this list.  Such situations do 
not necessarily imply an error but, if allowed to remain, will generate steep terrain (which may 
be intentional).  The same check may be performed on the data at any time using the Check 
Elevation Differences function in the Nodes menu. 
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Imported Data 
 

Starting “from Scratch” - If you are starting “from scratch” and the display is not blank, clear it 
with the Files menu New function – or close and restart Terrain Sculptor Pro.  If Flightsim is 
running, the display will be centered on the user aircraft.   
 
First, in the Mode menu, select the type of element to be created.  Then, in the terrain Type 
combobox, select the specific terrain type to be used.  Next, move the mouse to the 
approximate location of some point in the initial element, right-click, click  “Start …” in the 
context menu, select the type of element to be created and enter it’s elevation if it is to be flat, 
ie.e, all nodes at the same elevation.  You’ll be asked to name the element (it can be anything) 
or accept a default name, following which a red node will appear at the cursor location.  If hot-
cursor is enabled, simply, move the mouse to another location on the display and left-click.  The 
original node will change to the currently-specified color for that type of node and a new red 
node will appear at the cursor with a dash-dot line linking it to the original node.  And, so on, 
moving in a counter-clockwise direction.  Alternately, if hot-cursor is not enabled, right-click 
instead of left-clicking and select Add New … Node at Cursor Position from the context menu.  
In either case, it is essential that the previously-entered node be selected prior to the mouse 
click.  
 
If you plan to use the user aircraft to accurately place element nodes, just enter three nodes for 
polys or two for a line.  Then, in Flightsim and select top-down view.  Slew the user aircraft to 
where you want the first point of your contour.  Right-click over one of the nodes you entered 
earlier (or select it and right-click in an empty area) and select Move Node to A/C. Repeat for 
the other node(s), remembering the counter-clockwise “rule” for polys.  Now, starting at one of 
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the existing nodes (which must be selected), slew the user aircraft to a location counter-
clockwise of that node where you want another contour node, right-click and select Add Node at 
AC.  Repeat, until you complete the outline to the second of the initial three flattens.  Repeat 
until your contour is complete. 
 
Adding Sculpts – Sculpt nodes are added/moved like any other node.  However, since sculpt 
nodes are not ordered, the counter-clockwise “rule” doesn’t apply.  To add a sculpt node, move 
the cursor to where you want the node, right click, select Add Sculpt Node at Cursor location or 
Add Node at AC, as applicable, and enter the elevation of the point when the elevation entry 
dialog appears.  If it is the first sculpt node at any level, as for a new flatten you will be asked to 
name the collection or accept a default name and hot-cursor will be invoked if enabled. 
 
You may also convert one or more blend and/or contour nodes to sculpts by selecting the nodes 
to be converted, right-clicking on one of them and selecting Convert Selected Nodes to Sculpts 
from the context menu.  Any selected sculpt nodes are ignored, so the “rubber band” selection 
method may be convenient. 
 
Creating a Hole – While the runways, taxiways and aprons of Flightsim airports must be flat and 
level, there’s no need for the entire local area to be flat and level.  Few real-life airports are.  
You can add terrain features to your flatten, or insert a small area of alternate terrain by cutting 
a “hole” in a poly and filling it with whatever features you want.  Position the cursor inside an 
enclosed contour where an edge of the hole is to be, right click and select Start … a Hole from 
the context menu.  The usual naming process will occur and then a hole node appears.  Then, 
with that hole node still selected, move the cursor to the next position where you want a hole 
node and left click or right-click and select Add a Hole Node at the Cursor.  Continue to add hole 
nodes (counter-clockwise) as for any other outline.  The hole must be totally contained within 
the contour.  
 
Once the hole outline is complete, add sculpt nodes inside the hole or place an area of alternate 
terrain. 
 
Entering the Blend Outline – The blend outline is a series of points where you want Terrain 
Sculptor Pro to calculate node elevations that match the mesh elevation and, thus, create a 
smooth transition between your sculpted terrain and the surrounding mesh.  
 
If you’ve imported data incorporating sloping polys but that did not incorporate a blend outline, 
chances are you’ll want to place some of your blend nodes where you currently have a sculpt 
nodes.  But, you’ll likely want to add additional nodes as well.  If you are starting from scratch, 
you’ll be entering all the blend nodes anew.  As a suggestion, place your blend nodes at the top 
or bottom of significant changes in slope of the surrounding terrain.   
 
Your blend outline initially should be simply defined with the boundary placed in locations where 
minor discontinuities are unlikely to be noticed.  If the initial definition of the blend area does not 
produce satisfactory results, it’s easy to change. To “fine-tune” your blend nodes you may find it 
useful to slew the user aircraft using the ground elevation reported near the slew controls to 
locate more suitable locations.  (Terrain Sculptor Pro reports ground elevation under the user 
aircraft at the upper right side of the Main Panel. 
 
Whether starting from scratch or with imported data, position the cursor in the vicinity of where 
you want the first blend node, right-click and select Start the Blend Poly.  As with new contours, 
a new node will appear at the cursor location.  (You don’t name blend outlines since there can 
only be one and it is named “Blend Outline” by default.)  Then, if hot-cursor is enabled, position 
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the cursor where you want the next node (counter-clockwise) and left-click.  Otherwise, with the 
initial (or any other) blend node selected, right-click and select Add new blend node at cursor 
from the context menu.  Continue with the cursor at each successive counter-clockwise position 
for a blend node.  If a sculpt node already lies at that position, place the cursor over the sculpt 
node (it will turn orange) and then left click.  The sculpt node will be replaced by a blend node.  
 
If you haven’t already done so, save your data, using the Save or Save As items under the Files 
menu.  Give the file a distinctive name.  It will be saved with a “.tsd” file extension. 
 
Creating the Blend Profile – Now, the magic!.  Start Flightsim if necessary and click Profile 
Blend Outline in the Nodes menu.  The dialog below will appear.   
 
You may specify the distance between elevation sampling points (the smaller the number, the 
more profile nodes likely to be generated – and the longer the process will take) and the change 
in slope grade (%) at which you want a node automatically placed or accept the default values.  
(The “grade” at any point is the vertical distance the terrain rises or falls over the horizontal 
sampling distance divided by the sampling distance.)  You’ll have to experiment to see what 
works best for the surrounding mesh. 
 

 
 

Profile Blends Outline Dialog 
 

When you click Profile Blends, the user aircraft will be slewed to blend node 0 and will trace the 
blend outline, placing additional profile nodes at significant (as you specified) changes in slope.   
 
The profile is drawn progressively as the user aircraft moves.  The “pink” dots along the blend 
outline are the profile nodes.  Those not on top of brown blend nodes have been added by 
Terrain Sculptor Pro to address undulations in the mesh.  The profile shown below is for test 
purposes.  Normally, you’d have far fewer blend nodes and more system-placed profile nodes.) 
 
Before making the profile, ensure: 

 you have disabled any existing flatten files for your airport – unless you are sure none of 
your blend nodes fall on those flattens  

 the version of Flightsim running is the one with which the new flatten to be used, and  

 any add-on meshes are configured as you intend for your sculpted terrain. 
 

FS9 and FSX/P3D stock meshes are quite different and there’s little point in recording a profile 
that doesn’t reflect the mesh configuration with which your new flatten is to be used.  You will 
want to create a profile for each FlightSim version/mesh configuration with which the new terrain 
is to be used. 
 
When the trace completes, if it’s satisfactory, save the profile with a distinct name.  Profiles are 
saved with a “.tsp” file extension. 
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Main Panel with Blend Profile Shown 
 
The Next-to-Final Step – The next-to-final step in creating a sculpted flatten is triangulation of 
the sloping areas.  This section does not apply to other types of data. While certainly the most 
complex aspect of Terrain Sculptor Pro internally, all you need do is click on the Triangulate 
item in the Nodes menu.  If a blend profile is not already loaded, you will be asked to specify 
one.  The result is as shown below. 
 
While you won’t see it, Terrain Sculptor Pro draws a line between every pair of nodes that can 
be connected without crossing the contours.  Next, the longer of every pair of those lines that 
cross is eliminated.  Finally, the sculpted terrain is triangulated using the remaining (shortest) 
lines that connect each pair of points.  The result is as shown below.  While it would be possible 
to manually configure the triangles differently, in other than special situations, the smallest 
triangles are likely to produce the best overall result. 
 
Because Terrain Sculptor Pro uses the shortest possible lines to create its triangles, the end 
result may not be exactly as you would have done manually.  One potentially troublesome result 
is when a line passes very close to another node, creating a slope steeper than intended.  This 
is easily resolved by shifting the node slightly to the other side of the line and triangulate again. 
 
Liberal use of contours (which prevent sculpt nodes on either side being connected to each 
other) can make re-creation of difficult terrain a simple task.  Don’t be afraid to experiment.  If 
you don’t like the result, change it and re-triangulate. 

 
Triangulation is VERY processing intensive.  You may need to pause or close Flight Simulator 
before starting triangulation. 
 
The triangulated data is not saved since it can be regenerated so quickly. 
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Following triangulation, depending on the shape of your flatten(s) and the location and number 
of profile nodes, you may find one or more areas that are not included in the triangulated data.  
(The area covered by triangulated data will be shaded. Un-triangulated areas will not be 
shaded).  This is a result of TS Pro being unable to draw a triangle between nearby the nodes 
involved without one or more edges of that triangle intersecting the boundary of a flatten.  
Should this be the case, clear the profile, add an additional blend node to avoid the problem and 
re-triangulate.  (This sounds more complicated than it really is; the location of the needed blend 
node should be obvious once you see the problem.)  To avoid having to regenerate the profile, , 
if you know the elevation of the terrain at that location, you could place an additional profile 
node instead and simply re-triangulate. 
 

 
 

Data Triangulated 
 
There are two potentially-confusing situations that may develop during triangulation 
resulting in one or more triangles not being shaded: 

 any triangle whose nodes are all at the same (or very close to the same) elevation 
is considered to be a closed, flat contour – even if you don’t designate the area as 
such.  These areas are not shaded – but will be rendered as specified. 

 when a node lies on or VERY close to a line between two other nodes, it may not 
be triangulated; this situation can be rectified by moving the problem node 
slightly away from the line. 

 
Outputting your Terrain – Export your terrain to FlightSim, using the applicable export function 
from the Files menu.  Fire-up Flightsim and have a look. 
 
In the original version of TS Pro, all compilation for FSX/P3D was done with XML2Shp.exe.  
Unfortunately, XML2Shp is unable to compile freeways.  This version of TS Pro uses 
ArcShapeFile for compilation.  However, for some reason, neither FSX nor P3D “likes” the 
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exclusion shape files generated by ArcShapeFile.  So, XML2Shp is still used to compile “EXX” 
polygons. 
 
During the development of the latter version, an additional related function was added to the 
Nodes and Options menus.  The addition to the Nodes menu allows you to examine the 
contents of the generated .shp files.  The addition to the Options menu allows you to force 
compilation using only XML2Shp, which may be helpful in diagnosing shape file issues.  While 
neither is likely to find much use, I saw no reason to delete them. 
 
Should you need to “fine tune” things, tweak the loaded data, re-triangulate if necessary and 
recompile.  For flattens,there’s no need to regenerate the profile using FlightSim unless you 
change the blend outline.  And, even then, minor changes to the profile can easily be 
implemented by editing/shifting profile nodes and re-saving the profile prior to another 
triangulation.  
 
Finally, be aware that, from observation, FS9 may not render some steep slopes you 
create as well as does FSX or P3D – particularly when the slope ends at a flat enclosed 
contour (or flatten).  Such a steep slope often results in an unintended valley at the 
bottom of the slope and/or an unintended ridge at the top.  If this is a problem for you, 
you may be able to work around it by selecting all nodes in the contour/flatten and 
converting them to sculpts.  Otherwise, you may have no alternative but to reduce the 
slope. 
 
When working with FS9, be aware that you cannot exclude FS9 flattens.  Therefore, 
unless you want certain portions of the stock flatten to remain in effect, your new flatten 
must completely cover the stock flatten.  For FSX and P3D, you can (and should) exclude 
the stock flatten in the usual way, i.e. by creating an “exclude all flattens entry” when you 
create your new airport poly.  Once you exclude the old flatten(s), you can make your 
new flatten any size you wish. 

Background Display 

One of the most useful features of Terrain Sculptor Pro is its ability to display background 
images.  The background data may be either a .sbx tile or a terrain .bgl file.  (Future releases 
may support aerial, satellite photos as background.)  You may also include an airport image in 
your background data. 
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Main Panel with Background Display 
 

Background displays, such as shown below, are essential for the accurate placement of 
excludes for, for example, individual roads or other “corrections” to stock or other underlying 
data.  When photo-terrain is implemented, the placement of line-based features will become “a 
piece of cake”. 
 
A word of caution.  Stock data files generally are large, covering a much larger area than one in 
which you are likely to be interested.  Consequently, the display of stock data files may have a 
noticeable effect on the update of the display.  So, as noted above re importing of CVX files, you 
will have the option of limiting the amount of data imported using a bounding box.   
 
Background data is always displayed using a medium grey color and only in line mode.  To 
assist you in excluding information shown in the background display, the usual tooltips are 
displayed.  
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Support  

Terrain Sculptor Pro’s support forum is at http://www.fsdeveloper.com/forum/forums/terrain-
sculptor.146.  Please direct your queries and suggestions there.  
 
I also have a support website at http://stuff4fs.com for all my airports and development utilities. 
(Navigate to the User Applications / Terrain Sculptor Pro page.)  Among other things, the site 
lists all known problems with the latest release. The most recent release of Terrain Sculptor Pro 
is available from that site as are occasional development releases of new features.  
 
Don Grovestine  
don@stuff4fs.com  
http://stuff4fs.com  

 

 

 

 

 

End User License Agreement (EULA)  

As used in this end user license agreement, the term "Terrain Sculptor Pro” shall be construed 
as encompassing the full contents of the downloadable archive (.zip) file containing, without 
limitation: the executable file " Terrain Sculptor Pro.exe", the user manual, and/or certain third 
party content originally created and posted for distribution on “download sites” by the author, 
and any derivates thereof. 
 
You are granted a free, non-exclusive right solely to install and use Terrain Sculptor Pro on your 
computer system(s) for your personal enjoyment to create sculpted terrain data for use with 
Microsoft Flight Simulator® and Lockheed Martin’s Prepar3D®, and to distribute such sculpted 
terrain data in association with your own work product intended for use with Flight Simulator  
or Prepar3D.  
 
You may not:  

 upload Terrain Sculptor Pro, whether or not modified, in whole or in part, to any file 
distribution system,  

 reverse engineer, disassemble or decompile any part of Terrain Sculptor Pro,  

 incorporate Terrain Sculptor Pro in whole or in part into any commercial product or 
facility, “shareware” or “freeware”, or any other product or facility for which there is a 
charge of any kind, or  
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 use Terrain Sculptor Pro in the development, marketing or support of, or incorporate 
derivative files in, any commercial product  

  
without the express written permission of the author.  
 
Your use of Terrain Sculptor Pro is entirely at your own risk. The author accepts no liability 
whatsoever for any damage arising from its use no matter how caused.  
 
By downloading and installing this software, you are deemed to have agreed to the foregoing.  
 

Terrain Sculptor Pro © 2018-2021 - Don Grovestine 


